The software WMS is a product of the Aquaveo, LLC. For more information about this software and related products, contact Aquaveo at:

Aquaveo  
75 South 200 East, Suite 201  
Provo, Utah 84606  
Tel.: (801) 691-5528  
e-mail: wms@aquaveo.com  
WWW: http://www.aquaveo.com/

For technical support, contact Aquaveo’s tech support number at (801) 691-5530 (Monday-Friday, 8am-5pm Mountain Time)
# TABLE OF CONTENTS

1  **HEC-HMS DISTRIBUTED PARAMETER MODELING WITH THE MODCLARK TRANSFORM**  1-1
   1.1  **Introduction** ................................................................. 1-1
   1.2  **Watershed Delineation Using the Hydrologic Modeling Wizard** ...................... 1-1
   1.3  **Setup Gridded HEC-HMS Model** ........................................................................ 1-5
   1.4  **Hydrologic Input Parameters** ................................................................................ 1-6
   1.5  **Define Precipitation** ............................................................................................ 1-8
   1.6  **Clean Up Model** .................................................................................................. 1-9
   1.7  **Run HEC-HMS** .................................................................................................. 1-10
   1.8  **Conclusion** ........................................................................................................ 1-11

2  **DEVELOPING A GSSHA MODEL USING THE HYDROLOGIC MODELING WIZARD** .................. 2-1
   2.1  **Watershed Delineation Using the Hydrologic Modeling Wizard** ...................... 2-1
   2.2  **Select Model** ..................................................................................................... 2-5
   2.3  **Define and Smooth Streams** ............................................................................... 2-6
   2.4  **Create 2D Grid** .................................................................................................. 2-10
   2.5  **Job Control** ........................................................................................................ 2-10
   2.6  **Define Land Use and Soil Data** .......................................................................... 2-11
   2.7  **Hydrologic Computations** .................................................................................. 2-11
   2.8  **Define Precipitation** .......................................................................................... 2-14
   2.9  **Clean Up Model** ................................................................................................ 2-15
   2.10 **Run GSSHA** ...................................................................................................... 2-15
   2.11 **Post-processing and Visualization** ..................................................................... 2-15
   2.12 **Conclusion** ........................................................................................................ 2-20

3  **USING NEXRAD RAINFALL DATA IN HECHMS (MODCLARK) MODEL** ........................ 3-1
   3.1  **Open an Existing WMS Project** ......................................................................... 3-1
   3.2  **Creating Landuse and Soil Type Coverages** .................................................... 3-3
   3.3  **Defining Model Parameters** ................................................................................ 3-3
   3.4  **Defining Meteorological Data** .......................................................................... 3-5
   3.5  **Visualizing Meteorological Data** ..................................................................... 3-8
   3.6  **Saving the Model** .............................................................................................. 3-9
   3.7  **Running the Model** ............................................................................................ 3-10
   3.8  **Using Rainfall Hyetograph and Running the Model Again** ............................... 3-10

4  **USING NEXRAD RAINFALL DATA IN GSSHA** .......................................................... 4-1
   4.1  **Open an Existing GSSHA Project** ..................................................................... 4-1
   4.2  **Importing NEXRAD Rainfall Data** ................................................................... 4-2
   4.3  **Visualizing Meteorological Data** ..................................................................... 4-6
   4.4  **Saving the Model** .............................................................................................. 4-7
   4.5  **Running the Model** ............................................................................................ 4-7
   4.6  **Using Rainfall Hyetograph and Running the Model Again** ............................... 4-8
1.1 Introduction

In this tutorial we will see how a HEC-HMS model with the MODClark transform can be developed using the WMS interface. MODClark is a distributed transform method based on dividing the watershed into small grid cells of equal size and determining runoff from each of the grid cells.

The study site for this tutorial is Park City, Utah.

1.2 Watershed Delineation using the Hydrologic Modeling Wizard

In the following steps, you will use the Hydrologic Modeling Wizard to delineate the watershed. This will make you more familiar and comfortable using the wizard. The steps through the wizard are outlined briefly here.

1.2.1 Project Filename

1. Close all instances of WMS
2. Open WMS
3. Click on the *Hydrologic Modeling Wizard* button at the bottom of the WMS window
4. Click on the *Browse* button to specify the path location and set a file name for the project
5. Browse to `C:\Program Files\WMS84\tutorial\spatial\WMS`
6. For the File name enter “MODClark.wms” and click *Save*
7. Click on the *Save* button in the Hydrologic Modeling Wizard
8. Click *Next >* to advance to the next step

### 1.2.2 Define Project Bounds

1. Under Project coordinate system, select *Define…*
2. Select the *Global Projection* option
3. Click on the *Set Projection* button
4. In the Select Projection dialog set:
   - Projection to *UTM*
   - Datum to *NAD83*
   - Planar Units to *METERS*
   - Zone to 12 (*114°W - 108°W – Northern Hemisphere*)
5. Select *OK*
6. Set the Vertical Projection to *NAVD 88 (US)*
7. Set the Vertical Units to *Meters*
8. Select *OK*
9. Click *Next >* to advance to the next step

### 1.2.3 Watershed Data by Reading Files

1. Select the *Open file(s) only* option
2. Click on the *File | Open* button
3. Locate the folder `C:\Program Files\WMS84\tutorial\spatial\RawData\ParkCity` (all file folders referenced below are relative to this location).

4. In the `DEM` file folder open “ned_35172081.hdr”

5. Select `OK` to import the NED GridFloat DEM.

WMS reads the projection data that comes with the DEM and converts the DEM coordinates to the project coordinate system specified in section 1.2.2.

6. Click on the `File | Open` button.

7. In the `Luse` file folder open “salt_lake_city.shp”

8. Click on the `File | Open` button.

9. In the `SSURGO_Soil\Joinedsoil` folder open “SSURGO_Soil.shp”

10. Turn off the display of all GIS Layers in the Project Explorer.

Now you should be able to see the DEM contours behind the modeling wizard in the WMS main window.

11. Click `Next >` to advance to the next step.

### 1.2.4 Compute Flow Directions and Accumulations

1. Set the computational units for sub-basin areas to `Square Miles`.

2. Set the computational units for distances to `Feet`.

3. Select `Compute TOPAZ`.

TOPAZ uses the DEM data to compute flow directions and accumulations, which are used to infer the stream locations.

4. Click `Close` when TOPAZ terminates.

5. Set the Min flow accumulation threshold to `0.2 mi^2`.

6. Click on the `Apply to Display` button.

7. Click `Next >` to advance to the next step.
1.2.5 Choose Outlet Location

1. Choose the *Create Outlet Point* tool in the Hydrologic Modeling Wizard.

2. Click on the outlet location in the WMS graphics window using Figure 1-1 as a guide (you can use the middle scroll button of mouse to zoom in or out).

![Figure 1-1: Outlet location for Park City watershed](image)

3. Click *Next >* to advance to the next step.

1.2.6 Delineate Watershed

1. Make sure that the Stream threshold value is 0.2 mi^2.

2. Click on the *Delineate Watershed* button.

3. Save your WMS project by selecting *File | Save* in the main WMS window.

4. Click *Next >* to advance to the next step.
1.3 Setup Gridded HEC-HMS Model

1.3.1 Select Model
1. Set the model to be HEC-HMS ModClark
2. Click on the Initialize Model Data button
3. Click Next > to advance to the next step

1.3.2 Create 2D Grid
1. Make sure that the Enter cell size option is selected
2. For the X-dimension enter a cell size of 90 meters (the Y-dimension is automatically set to the same value as the X-dimension)
3. Click on the Create 2D Grid button
4. Select OK to interpolate elevations for each grid cell from the background DEM
5. Click Next > to advance to the next step

1.3.3 Job Control
1. Set the Starting date to 01/01/2008
2. Set the Starting time to 12:00:00 PM
3. Set the Ending date to 01/03/2008
4. Set the Ending time to 12:00:00 PM
5. Set the Time interval to 15 min
6. Click on the Set Job Control Data button
7. Click Next > to advance to the next step
1.4 Hydrologic Input Parameters

1.4.1 Define Land Use and Soil Data

Since you have already read land use and soil shapefiles, you are ready to convert these to feature data that can be used for computing hydrologic model input parameters.

1. Verify that Define land use shapefile is set to “salt_lake_city.shp”
2. Make sure that Define soil type shapefile is set to “SSURGO_Soil.shp”
3. Click on the Create Coverages… button
4. Select Next > in the GIS to Feature Objects Wizard

Notice that WMS automatically set the LUCODE in the shapefile to be mapped to the Land use parameter in WMS.

5. Select Next >
6. Select Finish
7. Repeat the same mapping process for the soil shapefile

WMS maps HYDGRP to SCS soil type, TEXTURE to Texture, KSAT to Hydraulic conductivity, MOISTURE to Initial moisture, FIELDCAP to Field capacity, and WILTINGPT to Wilting point.

8. Click Next > in the Hydrologic Modeling Wizard to advance to the next step

1.4.2 Hydrologic Computations

1. Click on the Compute GIS Attributes… button
2. For Grid Computation choose SCS Curve Number
3. Click on the Import button to import the mapping table file
4. In the C:\Program Files\WMS84\tutorial\spatial\RawData\ folder open “scsland.tbl”
5. Select OK

A curve number (CN) is computed for each grid cell by overlaying the 2D grid with the land use and soil polygons.
6. Click on the *Edit Parameters*... button to open the HMS Properties dialog

7. In the Display options portion of the dialog, toggle on the following:
   - *Loss Rate Method*
     - *Gridded SCS Curve Number*
   - *Transform*
     - *ModClark*

   Turning on these options adds the appropriate fields to the Properties section of the dialog. Some of the properties have already been calculated by WMS.

8. Set/enter values for the following properties (columns):
   - Area (mi^2): Computed by WMS
   - Loss Rate Method: *Gridded SCS Curve Number*
   - Initial abstraction ratio: **0.2**
   - Potential Retention Scale Factor: **1.0**
   - Transform Method: *ModClark*

9. In the Basin Data column after the Transform Method click on the *Compute*... button

10. In the Basin Time Computation dialog change Computation type to *Compute Lag Time*

11. Set the Method to *SCS Method*

12. In the Variables window at the bottom of the dialog highlight the “CN SCS curve number 0.000” line of text as shown in Figure 1-2
13. For the Variable value enter 72.49

14. Click on another line of text to see the CN value and lag time values updated in the list

15. Select OK

Scroll all the way to the right and make sure that the time of concentration and storage coefficient were calculated and entered appropriately.

16. Select OK in the HMS Properties dialog

17. Click Next > in the Hydrologic Modeling Wizard to advance to the next step

1.5 Define Precipitation

1. Click on the Define Precipitation... button to open the HMS Meteorological Model dialog

2. Set the Precipitation Method to User Hyetograph
3. Click on the *XY Series*... button to define the temporal distribution of the rainfall

4. Set the Selected Curve to *TypeI-24hour* as shown in Figure 1-3

![Figure 1-3: XY Series Editor for precipitation](image)

5. Select *OK* to close the XY Series Editor

12. In the Total Depth (in) column enter **3.5** inches

13. Select *OK*

14. Click *Next* > to advance to the next step

### 1.6 Clean Up Model

1. Click on the *Clean up Model* button

2. In the Redistribute Vertices dialog that appears, enter a vertex Spacing of **80** meters

3. Toggle ON the option to *Use Cubic Spline*

4. Select *OK*

5. When the model checker appears, fix any errors that appear

6. Select *Done* to close model checker

7. Click the *Save* button to save the WMS project file
8. Select Finish to close the Hydrologic Modeling Wizard

9. Select HEC-HMS | Save HMS File…

10. Locate the folder C:\Program Files\WMS84\tutorial\spatial\HMS

11. For File name enter “MODClark.hms” and click Save

You will see several black DOS windows pop up while saving the HEC-HMS input file. This is part of writing the gridded rainfall and CN DSS files. This is a normal part of saving your HMS project. It may take few minutes to save the project. If you do not see DOS windows popping up, then your HMS file is not saving correctly. Check the input data and make sure you have correctly followed all the steps in this tutorial.

1.7 Run HEC-HMS

We have successfully created the HEC-HMS input files needed to run a MODClark simulation on the Park City watershed. Now we will run HEC-HMS.

1. Open HEC-HMS 3.1.0 or a later version from the Start Menu

2. Select File | Open…

3. Open the HEC-HMS file you just created (C:\Program Files\WMS84\tutorial\spatial\HMS\MODClark.hms)

4. Select Compute | Select Run | Run 1

5. Select Compute | Compute Run [Run 1]

6. Select Close when HEC-HMS is finished computing

7. Click on the Results tab

8. Expand the Simulation Runs folder

9. Select Run 1 to view results

10. Select basin 1B

11. Select Graph

12. Your outflow hydrograph should look similar to Figure 1-4
1.8 Conclusion

In this exercise you learned how to compute gridded hydrologic model parameters required for a HEC-HMS model with the MODClark transform.
Gridded Surface Subsurface Hydrologic Analysis (GSSHA) is a physically based, distributed parameter, hydrologic model developed by the Engineering Research and Development Center of the Army Corps of Engineers. A detailed user’s manual and additional GSSHA tutorials can be found at [www.gsshawiki.com](http://www.gsshawiki.com). In this tutorial we will create a GSSHA model using data for Park City, UT and the Hydrologic Modeling Wizard.

Raw data for the Park City watershed can be found at `C:\Program Files\WMS84\tutorial\spatial\ParkCity`.

### 2.1 Watershed Delineation using the Hydrologic Modeling Wizard

#### 2.1.1 Project Filename

1. Close all instance of WMS
2. Open WMS
3. Click on the *Hydrologic Modeling Wizard* button at the bottom of the WMS window
The Hydrologic Modeling Wizard will guide you through the modeling process. You can follow each step from the beginning or jump in and out at any step as needed. All of the WMS menus/tools work while the wizard is open.

4. Click on the *Browse* button to specify the path location and set a file name for the project.

5. Browse to `C:\Program Files\WMS84\tutorial\spatial\WMS`.

6. For the File name enter “ParkCity.wms” and click *Save*.

7. Click on the *Save* button in the Hydrologic Modeling Wizard.

8. Click *Next >* to advance to the next step.

### 2.1.2 Define Project Bounds

1. Under Project coordinate system, select *Define*...  
2. Select the *Global Projection* option.
3. Click on the *Set Projection* button.
4. In the Select Projection dialog set:
   - Projection to *UTM*.
   - Datum to *NAD83*.
   - Planar Units to *METERS*.
   - Zone to 12 (114°W - 108°W – Northern Hemisphere).
5. Select *OK*.
6. Set the Vertical Projection to *NAVD 88 (US)*.
7. Set the Vertical Units to *Meters*.
8. Select *OK*.
9. Click *Next >* to advance to the next step.

### 2.1.3 Watershed Data by Reading Files

1. Click on the *File | Open* button.
2. Locate the folder `C:\Program Files\WMS84\tutorial\spatial\RawData\ParkCity` (all file folders referenced below are relative to this location)

3. In the `DEM` file folder open “ned_35172081.hdr”

4. Select OK to import the NED GridFloat DEM

WMS reads the projection data that comes with the DEM and converts the DEM coordinates to the project coordinate system specified in section 2.1.2.

5. Click on the `File | Open` button

6. In the `Luse` file folder open “salt_lake_city.shp”

7. Click on the `File | Open` button

8. In the `SSURGO_Soil\Joinedsoil` folder open “SSURGO_Soil.shp”

9. Turn off the display of all GIS Layers in the Project Explorer

Now you should be able to see the DEM contours behind the modeling wizard in the WMS main window.

10. Click Next > to advance to the next step

### 2.1.4 Compute Flow Directions and Accumulations

All GSSHA input files require metric units. WMS writes GSSHA input according to the model units rather than the computational units. This means that any of the options for computational units are valid because they are used for display purposes only.

1. Set the computational units for sub-basin areas to Square Miles

2. Set the computational units for distances to Feet

3. Select Compute TOPAZ

TOPAZ uses the DEM data to compute flow directions and accumulations, which are used to infer the stream locations.

4. Click Close when TOPAZ terminates

5. Set the Min flow accumulation threshold to 0.2 mi^2

6. Click on the Apply to Display button

7. Click Next > to advance to the next step
2.1.5 Choose Outlet Location

1. Choose the *Create Outlet Point* tool in the Hydrologic Modeling Wizard.

2. Click on the outlet location in the WMS graphics window using Figure 2-1 as a guide (you can use the middle scroll button of mouse to zoom in or out).

3. Click *Next >* to advance to the next step.

2.1.6 Delineate Watershed

1. Click on the *Delineate Watershed* button.

Your watershed will look somewhat like Figure 2-2.
2. Save your WMS project by selecting **File | Save** in the main WMS window.

3. Click **Next >** to advance to the next step

### 2.2 Select Model

1. Set the model to be **GSSHA**

2. Click on the **Initialize Model Data** button

3. Click **Next >** to advance to the next step
2.3 Define and Smooth Streams

All the streams defined so far in GSSHA are generic and they do not have any defined shape or geometry. Also, because of anomalies in the DEM elevations, some stream bed elevations will not decrease between upstream and downstream cells when the 2D grid is created. This “stream smoothing” problem creates issues when running a GSSHA simulation. In this step, we will define the channel cross section and roughness properties and we will also check and smooth the channel bottom.

After you define the channel data and smooth streams, WMS assigns the smoothed stream elevations to the 2D grid wherever streams intersect 2D grid cells. This prevents you from having adverse slopes between grid cells on the 2D grid.

2.3.1 Define Channel Geometry

For this example, we will assume that all the stream segments have the same cross section. You may enter different cross sections for individual stream arcs by selecting them and following the same procedure outlined in this section.

1. Select Display | Display Options
2. In the DEM Data tab toggle off the options for Stream and Flow Accumulation
3. Select OK
4. Turn off the display of the DEM (Converted) in the Project Explorer
5. Choose the Select feature line branch tool
6. Click on stream segment #1 as shown in Figure 2-3 (you may need to use the scroll bar on the mouse to zoom in)
7. Click on the Set Selected Arc Attributes... button
8. In the yellow All row of the spreadsheet:
   - Change the Type to Trapezoidal channel
   - For Manning’s n enter 0.025
   - For Depth (m) enter 1.0
   - For Bottom width (m) enter 3.0
   - For Side slope (H:V) enter 1.45
2.3.2 Redistribute Vertices

Before smoothing the streams, it is a good idea to redistribute the vertices on the streams because GSSHA requires a constant computational length between vertices along the 1-D streams. Also, we will make the spacing similar to the grid resolution.

1. Click on the Redistribute Vertices on All Streams... button

2. For Spacing enter 90.0

3. Toggle on the option to Use Cubic Spline

4. Select OK
2.3.3 Smooth Stream Thalwegs

After redistributing vertices, you will proceed to smooth the thalweg elevations of the continuous branches of the channel until all have been smoothed.

1. Select Display | Display Options
2. In the Map Data tab toggle on the option for Adverse Slopes
3. Select OK

Notice that streams with adverse slopes are displayed using the color defined in the display options.

4. Choose the Select Feature Arc tool
5. Select stream arc #1 as shown in Figure 2-3 and while holding down the shift key, select stream arcs #3, #7, #9, #14, and #15

Make sure that the selection of stream arcs is continuous and that it does not contain any branching streams.

6. Click on the Smooth Selected Stream Segments... button

In the Smooth GSSHA Streams dialog, shown in Figure 2-4, you will see a profile of the arcs you have selected. Notice that the segment has a general downward trend, but there are some places where the streambed slope is adverse. Even though GSSHA is able to handle adverse slopes, most of the adverse slopes are a result of the elevation data; it is not desirable to include adverse slopes that do not exist naturally in the model. We will mitigate this problem by making slight changes to the vertex and node elevations along the segment.
7. Click the *Interpolate Stream Elevations* button as many times as needed to generate a smooth stream segment with no uphill flow.

8. Select *OK*.

If uphill flow cannot be eliminated in this manner, you can edit individual points by selecting a point on the plot (hover directly over the point on the plot and move it up or down), then dragging the point to a new position or editing the Stream elevation value. Be especially careful to make sure the nodes next to the outlet are not adverse. You can zoom into individual points by clicking and dragging a box around section of the plot. It is also possible to pan in any direction by moving the scroll bars along the sides of the plot. Right-clicking on the plot will give you a menu with several choices, including options to output data from the plot, set display options, and frame the plot to its maximum extents.
Once the stream segment you have selected is smooth, select a new stream segment with an adverse slope or combination of segments to smooth. Repeat the smoothing process outlined in steps 4 through 8 until there are no stream segments with an adverse slope. Your streams are now ready for use in the GSSHA model.

9. Click Next > to advance to the next step

### 2.4 Create 2D Grid

Now that you have smoothed your streams, you are ready to create a 2D grid. When you create the grid, WMS assigns the smoothed stream elevations to the 2D grid wherever streams intersect 2D grid cells.

1. Make sure that the Enter cell size option is selected
2. For the X-dimension enter a cell size of **90** meters (the Y-dimension is automatically set to the same value as the X-dimension)
3. Click on the Create 2D Grid button
4. Select **OK** to interpolate elevations for each grid cell from the background DEM
5. Click **Yes** to delete the existing background DEM
6. Click Next > to advance to the next step

### 2.5 Job Control

1. Set the Starting date to **01/01/2008**
2. Set the Starting time to **12:00:00 PM**
3. Set the Ending date to **01/03/2008**
4. Set the Ending time to **12:00:00 PM**
5. Set the Time interval to **10** sec
6. Click on the Set Job Control Data button
7. Click Next > to advance to the next step
2.6 Define Land Use and Soil Data

Since you have already read land use and soil shapefiles, you are ready to convert these to feature data in the map module, which will be used to develop hydrologic input parameters.

1. Verify that Define land use shapefile is set to “salt_lake_city.shp”
2. Make sure that Define soil type shapefile is set to “SSURGO_Soil.shp”
3. Click on the Create Coverages... button
4. Select Next > in the GIS to Feature Objects Wizard

Notice that WMS automatically set the LUCODE in the shapefile to be mapped to the Land use parameter in WMS.

5. Select Next >
6. Select Finish
7. Repeat the same mapping process for the soil shapefile

WMS maps HYDGRP to SCS soil type, TEXTURE to Texture, KSAT to Hydraulic conductivity, MOISTURE to Initial moisture, FIELDCAP to Field capacity, and WILTINGPT to Wilting point.

8. Click Next > in the Hydrologic Modeling Wizard to advance to the next step

2.7 Hydrologic Computations

2.7.1 Create Index Maps

1. Click on the Compute Index Mapping Tables... button
2. For Input coverage (1) choose Land Use and set the Coverage attribute to Id
3. Enter an Index map name of “Land Use”
4. Click on the GIS Data -> Index Map button
5. For Input coverage (1) choose Soil Type and set the Coverage attribute to Texture
6. Enter an Index map name of “Soil Type”
7. Click on the GIS Data -> Index Map button

8. Toggle on the Input coverage (2) option so that you can create a combined index map based on both land use and soil type coverages

9. For Input coverage (2) choose Land Use and set the Coverage attribute to Id

10. Enter an Index map name of “Combined”

11. Click on the GIS Data -> Index Map button

12. Select Done in the GSSHA Maps dialog

You should see three index maps on the data tree under the 2D Grid Data. The GSSHA Map Table Editor dialog will automatically appear. You will now need to define the index mapping parameters.

2.7.2 Define Model Parameters using Index Map Tables

1. Switch to the Roughness tab (it is usually selected by default)

2. For the Using index map field select Land Use

3. Click on the Generate IDs button

IDs for each of the land use type polygons that overlay the 2D grid are generated and displayed.

4. Now switch to the Infiltration tab

5. Select Yes to turn the infiltration option on

6. In the Job Control Dialog, select the Green & Ampt option

7. Select OK

8. For the Using index map field select Combined

9. Click the Generate IDs button

This will generate a unique ID for all possible combinations of land use and soil type data within the watershed.

10. Switch to the Initial Moisture tab

11. For the Using index map field select Soil Type

12. Click on the Generate IDs button
13. Click on the *Import table…* button at the bottom part of the GSSHA Map Table Editor

14. Browse to folder `C:\Program Files\WMS84\tutorial\spatial`

15. Open the file “gssha.cmt”

**NOTE:** This table has typical values for the watershed parameters based on standard soil type and land use classification. Importing this table will populate model input parameters with the values in the file. Model input parameters should always be verified. One important thing to remember is that the values from the table are not absolute and the modeler needs to take ownership of them and adjust as necessary for the specific conditions of a given area. Generally these values are best estimated either by field measurement or by model calibration. Values obtained from this table should only be used as an initial estimate of the corresponding parameters.

16. Switch back to the *Roughness* tab

Notice the preliminary values for roughness that were entered based on the land use data. Enter a suitable number for any entry with a zero value.

17. Switch to the *Infiltration* tab

The values listed in this spreadsheet are based on soil texture only. Notice that the index map contains a land use and soil type for each index map ID. One would expect the infiltration values for sand in an agricultural area to be different from the infiltration value for sand in a residential area. Similarly, loam in a forest environment will have different infiltration values than loam in an industrial area. Based on your knowledge of how land use affects infiltration properties of the soil, make suitable adjustments to the default parameters.

18. Look at the land use IDs (refer to the land use table found in `C:\Program Files\WMS84\WMS Docs\USGS_landuse_codes.txt` to see the land use names and related IDs) and adjust Hydraulic conductivity, Capillary head, porosity etc. as necessary

19. Switch to the *Initial Moisture* tab

20. Enter values for initial moisture (make sure that the values you enter here are smaller than the values for porosity in the *Infiltration* tab)

21. Select *Done* in the GSSHA Map Table Editor dialog

### 2.7.3 Additional Model Parameters

1. Click on the *Edit Parameters…* button on the modeling wizard to open the GSSHA Job Control Parameters dialog
2. For Channel routing computation scheme choose \textit{Diffusive Wave}

3. Click on the \textit{Output Control} button

4. Under Gridded data sets toggle on the \textit{Cumulative infiltration depth} and \textit{Infiltration rate} options

5. Under Link / Node data sets toggle on the \textit{Channel Depth} and \textit{Channel flow} options

6. Change the Write frequency of these datasets to \textbf{15} min

7. Change the Hydrograph Write frequency to \textbf{5} minutes

8. Set the Hydrograph Output units to be \textit{English} (all computations in GSSHA are performed using metric units, but the outlet hydrograph will be automatically converted from m$^3$/s to cfs)

9. Select \textit{OK} to close the GSSHA Output Control dialog

10. Select \textit{OK} to close the GSSHA Job Control Parameters dialog

11. Click \textit{Next >} in the Hydrologic Modeling Wizard to advance to the next step

\section*{2.8 Define Precipitation}

1. Click on the \textit{Define Precipitation…} button

2. For Rainfall event(s) select \textit{Hyetograph}

3. Click on the \textit{Define Distribution…} button

4. In the XY Series Editor change the Selected Curve to \textit{typeI-24hour}

This is the temporal distribution of an SCS Type I - 24 hour storm.

5. Select \textit{OK}

6. Enter an Average Depth of \textbf{63.5} mm

7. Select \textit{OK}

8. Click \textit{Next >} to advance to the next step
2.9 Clean Up Model

You are done defining most of the parameters and components required for the model.

1. Click on the Clean Up Model button
2. In the Redistribute Vertices dialog that appears, enter a vertex Spacing of 90 meters
3. Toggle ON the option to Use a Cubic Spline
4. Select OK
5. Click Done to close the model checker
6. Click Close when CleanDam is finished running in the Model Wrapper
7. Click on the Save button to save the GSSHA project file
8. Browse to C:\Program Files\WMS84\tutorial\spatial\GSSHA
9. Enter “ParkCity.prj” and select Save
10. Select Finish to close the Hydrologic Modeling Wizard
11. Select File | Save to save the WMS project file

2.10 Run GSSHA

1. In the 2D Grid module select GSSHA | Run GSSHA
2. Toggle off the Suppress screen printing option
3. Select OK

The discharge at each time step is displayed in the model wrapper.

4. Click Close when the simulation is complete and WMS will read in the solution files

2.11 Post-processing and Visualization

This section of the tutorial describes different methods of viewing and visualizing GSSHA model results. GSSHA outputs multiple solution files including an outlet hydrograph file, a summary file, and solution data sets, which appear in two separate folders in the WMS Project Explorer. All 2D grid
data sets are displayed in the Solution folder that is part of the GSSHA model in the 2D Grid Data section of the Project Explorer. The link/node data sets that GSSHA outputs when channel routing occurs appear in a different Solution folder in the 2D Scatter Data section of the Project Explorer.

### 2.11.1 Outlet Hydrograph

1. Choose the *Select hydrographs* tool

2. Double click on the hydrograph icon that is displayed next to the outlet grid cell

This opens the runoff hydrograph in a plot window. Export the time series data for the hydrograph by right-clicking on the hydrograph plot window and selecting *Export/Print...*

3. Close the hydrograph plot window by clicking on the X in the upper right corner of the window

4. Select *Display | Display Options...*

5. In the *2D Grid* tab toggle OFF the display of everything except *Cells* and *Contours*

6. In the *Hydrologic Modeling* tab toggle OFF the display of *Hydrograph Icons*

7. Select *OK*

### 2.11.2 Summary File

1. In the 2D Grid Data folder of the Project Explorer expand the ParkCity GSSHA model folder, if necessary

2. Expand the Solution folder under the ParkCity GSSHA model, if necessary

3. Double-click on the *Summary File* in the Solution folder

4. If prompted to select an editor, click *OK*

   Look through the summary file. It is good to check things like the mass balance and the volume remaining on the surface to know that GSSHA is simulating the processes correctly.

5. Close the summary file when you are done viewing it
2.11.3 Grid Depth Contours

1. Toggle OFF the Coverages folder in the Project Explorer

2. Right-click on the “depth” data set in the Solution folder in the Project Explorer and select Contour Options…

3. Change the Contour Method to Color Fill

4. Click on the Legend… button

5. Toggle on the option to Display legend

6. Select OK

7. Select OK

8. Click on the first time step shown in the Properties window

Use the down arrow key (on the keyboard) to cycle through the time steps and view the overland flow depth. In this particular model overland flow depth values first become evident approximately 10 hours after the start of the simulation at 10:00 am on 01/01/2008. Skip ahead to this time step to view depth values.

2.11.4 Stream Depth Contours

1. Select the Stream depth data set in the ParkCity (GSSHA) solution folder under the 2D Scatter Data folder in the Project Explorer

2. Select Display | Display Options

3. In the Scatter Point tab toggle OFF the Symbols option and toggle ON the Contours option

4. Change the Radius to 30

5. Set the Z magnification to 100 (this only applies to the link/node stream depth contours)

6. Set the general display Z magnification (located on the left side of the dialog) to 2

7. Select OK

8. Use the Rotate tool to position the grid so that it appears similar to Figure 2-5
9. Click on the first time step shown in the Properties window.

Use the down arrow key (on the keyboard) to cycle through the time steps and view the channel flow depth. In this particular model channel flow depth values first become evident approximately 10 hours after the start of the simulation at 10:00 am on 01/01/2008. Skip ahead to this time step to view depth values. Notice the changing bar diagrams. These bars represent the flood wave magnitude along the stream at each time step.

Figure 2-6 shows the overland flow depth contours changing simultaneously with the flood wave bar diagrams. This gives a clearer idea of the natural process of overland flow.
2.11.5 Creating an Animation Film Loop

These processes can also be visualized in a film loop. WMS creates two types of file loops. One type is the standard .avi (movie) file and the other type can be viewed in Google Earth so that the flood animation is displayed over a Google Earth image.

1. Select Display | View | Plan View

2. Right-click on the “depth” data set in the Solution folder of the Project Explorer and select Contour Options…

3. Change the Contour Method to Normal Linear

4. Select OK

5. In the 2D Grid module select Data | Film Loop…

6. Choose the Create New Filmloop option

7. For Type select the Scalar/Vector Animation option and click Next >

8. Toggle on the Scalar Data Set option

9. Change the simulation run time to run from 550 to 700 (minutes from the start of simulation)
10. For Number of Frames enter 30

11. Click Next >

12. Click Finish (do not change the clock options)

WMS will take some time to create the film loop. It will automatically begin playing once it is completely saved. If Google Earth is installed, Google Earth will start and the movie will appear in the correct geographic location. If Google Earth is not installed, the AVI file will run in a movie player. If the data seems somewhat jumpy while scrolling through the time steps (or making a movie) this is because output time step is too large.

2.12 Conclusion

In this exercise you learned how to set up a basic GSSHA model, including channel routing, using the Hydrologic Modeling Wizard. The wizard guides you through the processes of delineating a watershed, creating a 2D grid, entering GSSHA job control data, defining and smoothing streams, and developing hydrologic input parameters. Options for post-processing GSSHA model results were also introduced.
In this tutorial we will see how the NEXRAD rainfall data can be used in an HEC-HMS MODClark model. We will begin with an existing WMS project file with a watershed already delineated and build a MODClark model. Then we will use NEXRAD data for the precipitation. We will also compare the results from NEXRAD gridded precipitation method and user hyetograph precipitation methods.

### 3.1 Open an Existing WMS Project

Here we will open a WMS project file for Park City watershed and keep building on it.

1. Select **File | Open**. Browse and open the file, *C:\Program Files\WMS84\tutorial\spatial\HMS\NEXRAD\BaseProj.wpr*
2. Save the project with new name so that the original project remains unchanged. Select **File | Save As...** and save the file as `C:\Program Files\WMS84\tutorial\spatial\HMS\NEXRAD\nexrad.wms`.

3. Make sure that the coordinate system is correct. Select **Edit | Current Coordinates**…

   Horizontal system: *UTM NAD 83 (US)*
   
   Units: *Meters*
   
   UTM Zone: *12*
   
   Vertical System: *NAVD 88(US)*
   
   Units: *Meters*

4. Click **OK**

5. Open the Hydrologic Modeling Wizard dialog by clicking the button.

6. On the left side of the wizard dialog, click on the **Select Model** option as we have already performed all other processes

7. Select your model to be *HEC-HMS MODClark*

8. Click on **Initialize Model Data**

9. Click **Next** on the wizard.

10. Enter the cell size of **90**

11. Click on the **Create 2D Grid** button.

12. Click **OK** to interpolate background elevation from DEM.

13. Click **Next** on the wizard

14. Set the job control data (**07/25/2007, 6:00:00 PM** to **07/26/2007, 6:00:00 PM**). Set the time interval to be **15 min**

15. Click on the **Set Job Control Data** button

16. Click **Next** on the wizard
3.2 Creating Landuse and Soil type Coverages

Here we will create two coverages, read in soil and land use data and map these data to WMS coverages.

1. Click on the Open button next to Define land use shapefile: and open the file C:\Program Files\WMS84\tutorial\spatial\RawData\ParkCity\Luse\salt_lake_city.shp. You should now see the land use shape file added to the GIS Layers in WMS Project Explorer.

2. Likewise, click on the Open button next to Define soil type shapefile: and open the file C:\Program Files\WMS84\tutorial\spatial\RawData\ParkCity\SSURGO_Soil\Joinedsoil\SSURGO_Soil.shp. You should now see soil type shape file added to the GIS Layers in WMS Project Explorer.

3. In the wizard, click on the Create Coverages... button to create land use and soil coverages and map the corresponding shape file polygons to their respective coverages. You will need to navigate through the attribute mapping dialogs by selecting Next, Next, and Finish in each dialog when prompted.

4. Click on Next in the modeling wizard.

3.3 Defining Model Parameters

1. Click the Compute GIS Attributes button which will open the Compute HMS Loss Method Attributes dialog.

2. Toggle on SCS Curve Number.

3. Make sure that the soil type and land use coverages are mapped in correctly.

4. Click on the Import button. Browse and open the file C:\Program Files\WMS84\tutorial\spatial\RawData\scsland.tbl.

5. Click OK to assign curve numbers to the grid from the land use and soil data defined in this dialog. You should be able to see that the Curve Number grid has been added to the data tree under 2D Grid Data.

6. Click OK.

7. Click on the Edit Parameters button.
8. In the HMS Properties dialog, in the Display options portion of the dialog, select the following

- Loss Rate Method
  - Gridded SCS Curve Number
- Transform
  - MODClark

Turning these options will add fields in the Properties area and some of the values are calculated by WMS.

9. Set and/or fill in the following values in the rest of the fields:

- Basin Area is computed by WMS
- Make sure that the Loss Rate Method is Gridded SCS Curve Number
- Initial Abstraction Ratio = 0.2
- Potential Retention Scale Factor = 1.0
- Transform Method = MODClark

10. Click on the Compute... button under basin data. In the Basin Time Computation dialog change Computation type to Compute Lag Time and Method to SCS Method

Notice the variables required for the SCS lag time equation listed in the box at the bottom of the dialog. Although you have computed a Curve Number grid, you still need to enter a composite curve number value in the lag time equation

11. Check to make sure the CN variable in the Variables window is not 0.0. If it is, click on the CN variable in the Variables window, enter a CN value of 72.46 in the Variable value edit field to the right of the window, then click on any other variable in the Variables window so that the CN value gets updated

12. Check to make sure there are no zero values among the Lag Time variables and click OK. See Figure 3-1.
13. Scroll all the way to the right and make sure that the Time of Concentration (hr) and Storage Coefficient (hr) are calculated. WMS converts the lag time to a time of concentration using the SCS equation.

14. Click OK

15. Click Next

### 3.4 Defining Meteorological Data

So far in all of your models you have been using either uniform intensity rainfall or SCS storm. Here you will use NEXRAD RADAR rainfall data.

1. Click on the Define Precipitation button.

2. Select Gridded Precipitation for Precipitation Method

Since you do not have a DSS file for the precipitation grid, you need to create it. You will first open the NEXRAD files and convert them to DSS.

3. Click on Convert ASCII or XMRG files to DSS...
4. In the Convert Grids dialog that opens, make sure that Grid Conversion Information is set to Arc/Info ASCII Grid to DSS.

5. Click Add Files... button. Browse to C:\Program Files\WMS84\tutorial\Spatial\RawData\ParkCity\NEXRAD

6. In the Open file browser, change the view menu to Details (Figure 3-2).

![Figure 3-2: Change the view menu to Details]

7. Click on the Type column label to sort the files by type

8. Select the last time grid which is KMTX_NTP_20070726_0358.asc as shown in Figure 3-3
9. Hold shift key and select first time grid which is KMTX_NTP_20070725_1801.asc. Click Open.

10. In the Convert Grids dialog, make sure the Convert inches to millimeters option is toggled off (Figure 3-4).
11. Click on the Browse button and browse to the folder/file `C:\Program Files\WMS84\tutorial\spatial\HMS\NEXRAD\radarrain.dss` and click Save. It is advisable to select a different name than the HMS file you will later save (this will separate the gridded precipitation dss from the project dss and help keep your files straight).

12. Set the Starting date to **7/25/2007** and the Starting time to **6:00 PM**. Make sure the time interval is set to 1 hour (60 min) and click OK.

13. Click OK to save the grid file in the location you specified. It might take some time to save the grid. You will see a few black DOS windows popping up at the end of the process.

For more information on how this process is carried out, see [http://www.xmswiki.com/index.php?title=WMS:Radar_Rainfall](http://www.xmswiki.com/index.php?title=WMS:Radar_Rainfall)

14. As soon as the saving process completes, a summary file will open up showing the date/time and rainfall depth at each time interval (Figure 3-5). Minimize this file; you will need it later on.

![Figure 3-5: NEXRAD Radar Data summary report](image)

15. Click OK

### 3.5 Visualizing Meteorological Data

Before continuing, let us visualize the gridded rainfall data.
1. Select Close to close the wizard dialog.

2. Turn off the display of soil type and land use coverages as well as the GIS layers by un-checking them in the data tree. This will help you zoom into the watershed area for better visualization.

3. Right click on Rainfall Cumulative on the data tree under 2D Grid Data and select Contour Options... Select Color Fill for the Contour Method. Click OK.

4. Click on Rainfall Cumulative on the data tree under 2D Grid Data to make sure that it is active.

5. Select the first time step in the properties window and with the down arrow key on your keyboard, step through the time steps to see how the precipitation varies.

There are two rainfall datasets, one is incremental and the other is cumulative. You may choose to view the incremental rainfall data set in the same way you viewed the cumulative data set. You may choose either dataset for creating the film loop.

6. In the 2D Grid Module select Data | Film Loop... Specify the folder where you want to have the animation saved, toggle off the option to Export to KMZ (Google Earth) and click Next.

7. Toggle on Scalar Data Set and make sure that either (Rainfall Cumulative) or (Rainfall Incremental) appears next to it.

8. Click Next.

9. Click Finish.

WMS may take a few moments to create and save the animation file. The animation will start playing as soon as the saving process is complete. Try to visualize how rainfall is changing over the watershed over time. Let us now continue working with the model.

### 3.6 Saving the Model

1. Open the Hydrologic Modeling Wizard dialog again by clicking the button.

2. Click Clean Up Model on the left side of the dialog.
3. Click on the Clean Up Model button which will perform the several operations that are toggled on.

4. Click OK to accept the default values for stream redistribution.

5. In the model checker, fix any errors that may be listed, then click Done to close the model checker.

6. Click Finish to close the modeling wizard dialog.

7. Switch to the Hydrologic Modeling Module and select HEC-HMS | Save HMS file.

8. Save the HMS file as C:\Program Files\WMS84\tutorial\spatial\HMS\NEXRAD\wmsexport.hms

### 3.7 Running the Model

We have successfully created an HMS MODClark file for the Park City Watershed. Now we will work inside the HMS interface.

1. Minimize the WMS window and open HEC-HMS

2. Select File | Open. Browse and open C:\Program Files\WMS84\tutorial\spatial\HMS\NEXRAD\wmsexport.hms. If you do not have the .hms file saved properly, you may open it from C:\Program Files\WMS84\tutorial\spatial\HMS\NEXRAD\finished\wmsexport.hms

3. Run the model (sometimes you must run the model twice for the results to be active)

4. View the results

### 3.8 Using Rainfall Hyetograph and Running the Model Again

1. Return to WMS

2. In Hydrologic Modeling Module select HEC-HMS | Meteorologic Parameters

3. Change Precipitation Method to User Hyetograph and click on XY Series button

4. Open the summary file which we had previously minimized and copy the distribution from the summary file to Excel
5. Make sure that the incremental/cumulative depths are in inches (if not use conversion factor or 1 inch = 25.4mm to convert)

6. Copy and paste the time in minutes and the cumulative distribution into the XY series editor (NOTE: WMS will accept a temporal rainfall distribution that is either dimensional or dimensionless. If a dimensional distribution is entered, WMS will normalize the curve and make it dimensionless before applying the total rainfall depth to the distribution)

7. Enter total rainfall depth (0.92 in. in this case)

8. Select OK

9. Save the HMS project file

10. Run HMS

11. View the results and compare with the previous run
CHAPTER 4

Using NEXRAD Rainfall Data in GSSHA

In this tutorial, you will see how NEXRAD rainfall data can be used in GSSHA. You will begin with an existing GSSHA project file. You will see how NEXRAD data can be processed for GSSHA and view the difference in results between using gage-based and distributed rainfall.

4.1 Open an Existing GSSHA Project

Open a WMS project file for Judy's Branch watershed in Illinois and use NEXRAD radar rainfall for the project.

1. In the 2D Grid Module select GSSHA | Open Project File…
   Browse and open the file C:\Program Files\WMS84\tutorial\spatial\GSSHA\BasicGSSHA\FullModel.prj

2. Make sure that the coordinate system is correct. Select Edit | Current Coordinates…
   Horizontal system: UTM NAD 83 (US)
   Units: Meters
   UTM Zone: 16
   Vertical System: NAVD 88(US)
   Units: Meters

3. Click OK

4. Right click on the GSSHA coverage and choose Zoom to Layer
4.2 Importing NEXRAD Rainfall Data

NEXRAD rainfall datasets have already been downloaded for this watershed. For information on how to obtain your own radar rainfall datasets, see http://www.xmswiki.com/index.php?title=GSDA:Obtaining_NEXRAD_Radar_Data_from_NCDC

1. In the 2D Grid Module select **GSSHA | Precipitation**. Under **Rainfall event(s)** select Nexrad Radar

2. Click on **Import Radar Data**... button which will open the Convert Grids dialog

3. In the Convert Grids dialog, make sure that **Grid Conversion Information** is set to **Arc/Info ASCII Grid to Incremental Distribution Rain gages**

4. Click the **Add Files**... button and browse to **C:\Program Files\WMS84\tutorial\spatial\RawData\JudysBranch\NEXRAD**

5. In the Open file browser, change the View Menu to Details (Figure 4-1)

![Figure 4-1: Change the view menu to Details](image)

6. Click on the **Type** column heading to sort the files by Type

7. Select the last time grid which is **KLSX_NTP_20080508_1657.asc**
8. Hold the *Shift* key and select the starting time grid which is *KLSX_NTP_20080507_1200.asc* (Figure 4-2). Click *Open*

9. In the Convert Grids dialog, toggle on the option *Convert inches to millimeters* (if it is not already on)

10. Toggle on *Create 2D grid rainfall dataset* option. Make sure that the time interval is 1 hour (60 min)

11. Change the *Starting date* to 05/07/2008 and the *Starting time* to 12:00:00 PM (Figure 4-3)
12. Click OK to save the grid file. It will take some time to save the grid.

13. As soon as the saving process completes, a summary file will open up showing the date/time and rainfall depth (mm) at each time interval. Minimize this file; you will need it later on (Figure 4-4).

You should now see many gages covering the watershed and a network of polygons joining the gages. You should also notice a new Gridded Rainfall Gages coverage in the coverage tree.
14. In the GSSHA Precipitation dialog, toggle on the *Gridded Rainfall Gages* option and click *OK*.

15. The WMS window should look similar to Figure 4-6.
4.3 Visualizing Meteorological Data

Before continuing, let us visualize the gridded rainfall data.

1. Toggle off the display of the Soil Type and Land Use coverages

2. Right click on Rainfall Cumulative on the data tree under 2D Grid Data and select Contour Options... Select Color Fill for the Contour Method. Click OK

3. With the down arrow key on your keyboard, step through the time steps in the properties window on the right sidebar to see how the precipitation varies.

There are two rainfall datasets, one is incremental and the other is cumulative. You may choose to view the incremental rainfall data set in the same way you viewed the cumulative data set. Whichever dataset is selected will be used to create the film loop.

4. In 2D Grid Module select Data | Film Loop... Specify the folder where you want to have the animation saved, check off the option to Export to KMZ (Google Earth) and click Next
5. Toggle on Scalar Data Set and make sure that either (Rainfall Cumulative) or (Rainfall Incremental) is shown next to it.

6. Click Next

7. Click Finish. WMS will now a few moments to create and save the animation file. The animation will start playing as soon as the saving process is complete.

Let us now continue working with the model.

### 4.4 Saving the Model

We have now imported the NEXRAD rainfall into GSSHA and copied the data into the Gridded Rainfall Gages coverage. Next we will save and run the model.

1. Select GSSHA | Save Project file… Save it as C:\Program Files\WMS84\tutorial\spatial\GSSHA\NEXRAD\nexrad.prj.

### 4.5 Running the Model

1. Select GSSHA | Run GSSHA….

2. Toggle off the option to Suppress screen printing.

3. Click OK

4. Once GSSHA has finished running, click Close

5. In the Project Explorer, under 2D Grid Data, you should see a folder with the letter “S” on it. This represents the GSSHA solution files. Click on the dataset labeled depth to make it active

6. Right click on the depth dataset and choose Contour Options...

7. Change the Contour Method to Color Fill

8. Click on the first time step in the properties window and scroll through the depth dataset using the down arrow key to view the watershed response. If you wish to create a film loop of the watershed response, follow the steps outlined in section 4.3

9. With the Select Hydrographs tool selected, double-click on the hydrograph icon to view the runoff hydrograph at the watershed outlet
10. Right click on the hydrograph plot and choose View Values... to view the runoff time series. Copy and paste the time series values to Excel in order to compare with the results from the next section.

### 4.6 Using Rainfall Hyetograph and Running the Model Again

1. Make sure you are in the 2D Grid Module.

2. Right click on Coverages in the Project Explorer and select New Coverage.

3. Change the type of the coverage to Rain Gage and click OK which will add coverage on the data tree under coverages.

4. Click on the Rain gage coverage and choose Create Feature Point Tool. Click on the white area just outside your watershed boundary so that it will be easier to locate and make sure you are not too far away for the watershed. This will add a rain gage to the watershed. Next we will define the rainfall hyetograph data for this gage.

5. Choose Select Feature Point/Node tool and double click the gage that you just created.

6. In the Rain Gage properties dialog, make sure the Gage Type is set to GSSHA and click on the Define... button which will open the XY Series editor window. In the XY Series Editor.

7. Toggle off the option Show Dates.
11. Open the summary file which we had previously minimized and copy the contents of the summary file to Excel.

12. Make sure that the incremental/cumulative depths are in millimeters (if not use conversion factor or 1 inch = 25.4mm to convert).

13. Copy and paste the columns labeled time in minutes and incremental distribution to the XY series editor (Figure 4-7).

14. Now check the option to **Show Dates**. Set the date to be **05/07/2008** and time to **12:00:00 PM**. Click **Select**.

15. Click **OK**.

16. Click **OK** to close the Rain gage property dialog.
17. Switch to the 2D Grid Module and select **GSSHA | Precipitation** again

18. Toggle off Gridded Rainfall Gages and select **Rain Gage**

19. Click **OK**

20. Select **GSSHA | Save Project File…** and save the project with a new name: 

   `C:\Program Files\WMS84\tutorial\spatial\GSSHA\NEXRAD\nexrad2.prj`

21. Run GSSHA (**GSSHA | Run GSSHA…**)  

22. View the results

23. The hydrograph plot for this model should be plotted on the same hydrograph as the last model run. Open the hydrograph plot to compare results. For a more thorough comparison, copy the hydrograph ordinates to Excel and compare results there.